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Introduction

genie - ,/l/,\/ provides the right solution for all your control needs!

Providing excellent performance and functionality, Genie-NX performs simple logic, timing, counting, and real time clock operations. It is an
ideal programmable controller for simple control applications such as building construction equipments, HVAC, parking lot lighting and
other applications in which cost is a primary design issue. All programming and data adjustments can be done via the on-board keypad and

display or with the help ofa software.

Programming Genie-NX with the help of G-Soft NX configuration software is quite simple, without particular programming knowledge. It
facilitates program generation, project simulation and documentation which are accomplished simply using the pick and place functionality,

allowing maximum ease of operation.

Some of'its features are:

Integrated, ready to use, wide range of programmable functions including 16 timers, 16 (retentive
selectable) counters, 16 time switches, 16 compare counters, 16 soft text messages, 32
auxiliary relays and 12 analog comparators.

8 digital inputs & 4 relay outputs . Two analog inputs (0 -10V) in 12 -24VDC, model which can be
used as digital inputs.

Ability to add up to three(3) extension modules expanding I/O’s to 32 digital inputs, 16 relay outputs.

Communication module allows programmable relay to be connected to a Modbus network through
RS 485 link

Backlit LCD screen for display and modification of pre-selected parameters of function blocks,
viewing I/O status and programming on the device .

Ladder programming using software on PC as well on the device with the help of keypad & LCD Display Base Module

Memory back up allowing programs to be transferred or copied into another Genie NX with the
help of amemory card.

Compact size —only 72mm (2-53/64") wide x 90mm(3-35/64”) high x 65 mm (2-9/16) deep, reducing
panel area requirements for lower installed costs.

Softkeys for convenient creation and editing of programs on the device.
Available in both: AC(110 - 240 VAC) & DC(12 - 24 VDC) models.

Password & Parameter lock facility.
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EXTENSION MODULE

Extension Module can be used with base module to increase I/O capacity of Genie-NX.
Every extension module has 8 digital inputs & 4 digital outputs. Fatension Module
Connections are made in Daisy chain fashion.

Genie-NX can be expanded by connecting 3 extension modules, to obtain a maximum configuration of
32 inputs and 16 outputs.

COMMUNICATION MODULE (.4 Comm )

ACCESSORIES

e/l/,\/— Comm (RS 485) provides Modbus communication for Genie NX.
Possible to connect multiple Genie’s witha SCADA system ora HMI over RS 485.
Available inboth AC (110-240 VAC ) & DC (12 - 24 VDC) models.

USB Cable Communication Cable Serial Cable Memory Card

Communication Module
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FRONT VIEW OF KEYPAD & FUNCTIONS OF KEYS

The 8 keys located on the front facia of Genie-NX are used to configure, program and control the application.
They perform the following actions:

DEL
This key is used to delete a program element or a blank line, if the cursor is located at the extreme column.

ALT

This key is used for selecting/exiting a parameter in the edit mode and to show either the Parameters or Program
while the program is running. This feature is also useful for debugging.

OK

This key to is used to insert a program line, when cursor is blinking in the first column of first row. During the

parameter entry while editing this key saves the changes and proceeds to next parameter. In RUN mode, this key

can be used to select one of the 3 displays. This also selects/deselects links.

ESC

This key is used to exit the menu or a selection. During the parameter entry it proceeds to the next parameter without saving the changes.

ARROW

On the program editor screen, the arrow keys are used to move up, left, down and right. The position on screen is shown by a cursor or
blinking text

AUXILIARY or Z-Keys

Arrow keys are called auxiliary keys in Run mode. They are used as push buttons to get signals from user. If user goes in PAR (parameter
mode), then these keys are not available as z-keys. At that time these keys are used as arrow keys



Wiring Diagrams

SUPPLY, INPUT & OUTPUT CONNECTIONS
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Power Supply Wiring

1. Although the Genie has been designed to withstand the negative effects of any electrical noise that might be present in the incoming power supply it may be necessary
to insert an isolation transformer between the supply and the line terminals of the Genie.

2. While using the DC Genie-NX, run the 24 VDC Input line away from the 100 V AC and 200 V AC lines.

Wiring of Input/Ouput
1. Separate the Input lines and output.
2. When the output lines are running close to power supply lines or the Input lines use batch shielded and ground them.
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Programming the Genie-NX at the Device: Menu ¢ Functions

Programming and other settings in Genie NX can be done using the software

PROGRAM OK EDIT I e Q1 as well as on the device itself with the help of the backlit display and keypad.
RUN DELETE OK . . .
» > When the connections are made and the device is powered ON, screen 1 is
PARAMETER TRANSFER 12 e T1 . . el . y
UTILITIES MODBUS CONF displayed on the device. By default the cursor will blink on the ‘PROGRAM
option. Using the Up, Down keys, user can select between any of the options.
Screen 1 = Screen 2 Screen 6 When the cursor is on the PROGRAM option and OK key is pressed, then
screen 2 is displayed.
When screen 2 is being displayed, the cursor is on the ‘EDIT’ option.
EDIT DELETE! Press the OK key to enter this option & screen 6 will be displayed. Similarly
DELETE OK by pressing down key and OK, one can enter the other functions viz.
TRANSFER ’ “DELETE”, “TRANSFER”, “MODBUS CONF” and screen 7,8 and 9 will be
MODBUS CONF displayed respectively
2 Screen 7 EDIT
This function allows the user to enter a new program or edit an existing
= e T program. If Password is set, then this function is accessible only with the
2 correct password.
DELETE OK DEVICE > CARD P
TRANSFER > DELETE CARD DELETE _ , _
MODBUS CONF This function will clear the entire program stored in the Genie-NX. If
password is set, then this function will work only with correct password.
P i Screen 8 TRANFER
This function will transfer the program from device to memory card or vice
EDIT SLVID 000 versa. Program data on memory can also be deleted in this mode.
DELETE ok _ BAUD 9600 MODBUS CONFIG
TRANSFER > PARITY NONE This function will set Mod bus Slave configuration data.
MODBUS CONF STOPBIT 1 The user can set the following communication parameters:
*SLAVEID,BAUD RATE, PARITY, STOPBIT
Screen 9
When screen 1 is being displayed, press the down key to shift the cursor to the
 / RUN option and press OK key to enter it. Screen 3 will be displayed.
PROGRAM CONTINUE RESET
RUN OK’ RESET The RESET Mode resets all the previous states of Inputs/Outputs, clears
PARAMETER timer and counter states, starts afresh.
AL CONTINUE
Screen 3 The CONTINUE Mode does not change the states of the Inputs/Outputs and
z2 special functions and continues with the execution of the program.
¢ When the cursor is on PARAMETERS option and OK is pressed then screen 4
will be displayed.
A o |om| rer PARAMETERS
> This function displays and allows the user to change parameters of special
PARAMETER CNT |C1 Y functions like ti tor. Ti iteh (clock " q
UTILITIES RES ctions like timer, counter, Time switc (clock), compare counters an
analog functions used in the program. This may be password protected and
72 ‘ Screen 4 may have additional individual lock for each parameter.
PROGRAM SET CLOCK DD/MM/YY When tsh'e ggrslc)r 1sdon the UTILITIES option and OK key is pressed, then
oK screen 5 is displayed.
RUN > PASSWORD OK 01/01/2011 L . . .
PARAMETER EXT MOD — > HH:MM When screen 5 is being dlsplgyed, .the cursor is on th_e SET.CLOCK option.
UTILITIES BACKLIT CONF 10:40 Press the OK cy to enter this optlon screen 1 wi € displayed. dSimilarly
. he OK k h & 1 will be displayed. Similarl
y pressing down key and OK, one can enter the other functions viz.
b, ing d k d O he other functi i
. Screen 5 Screen 10 “PASSWORD”, “EXTMOD”, “BACKLIT CONF” and screen 7,8 and 9 will
be displayed respectively
SET CLOCK PASSWORD SET CLOCK
PASSWORD | OK This function is used to set the day and time: Day of the week, Date, Hours-
gﬁg PQ/ILIO'IPCON F 0000 Minutes. This function is available only on Genie-NX unit.
PASSWORD
. Stgigga Il This function allows setting of password. If password is set, certain functions
like Program, Parameters are protected and are accessible only when correct
password is entered. The Password can be set or removed; the status is
SET CLOCK EXTENSION indicated by the open or closed lock symbol.
E,)A(?_S'\AWO%RD Ok MODULES PASSWORD
BACKLIT CONF A B c This function allows the selection of the Extension Modules (A/B/C).
Maximum 3 Extension Modules can be connected to the Genie-NX Main
Screensi? Unit. In the G-SOFT NX on PC, extension modules have to be chosen using
2 the "Configuration" menu.
BACKLIT CONF
gE;SCngcR;E BACKLIT This function allows the setting of backlight in either On, Off or Auto mode.
EXT MOD ¢> CONFIG In the Auto mode, the backlight comes up only when a key is pressed on the
BACKLIT CONE AUTO device and remains for 10 seconds. If the ON or OFF modes are selected the

Screen 13

backlight will be permanently ON or OFF respectively.



Ladder Programming Elements / Function Blocks

In ladder programming, the ladder elements / Functional Blocks are connected to create a ladder for any application. The following section gives the description of

each element that is used for ladder programming.

INPUTS

Genie-NX provides 2 types of Inputs viz. Digital & Analog
AC Model: Digital Inputs (1 - 8)

DC Model: Digital Inputs (1 - 6), Analog Inputs (V1, V2)

11,12, ..... 18 Base Module
J1,32, ... 18 Norrélally Open | Extension Module 1
ontact -
K1,K2, ..... K8 (’NO’ Contact) Extension Module 2
L1,L2, ... L8 Extension Module 3
il, i2, ..... i8 Base Module
jl,j2,.....38 Noméally Closed Extension Module 1
ontact -
k1, k2, ..... k8 ("NC’ Contact) Extension Module 2
11,12, ..... 18 Extension Module 3

OUTPUTS

Genie-Nx provides Digital Outputs: Base Module (4), Extension Module (4)
The outputs can be configured as:

L. State Change (Contactor), ii. Level Change (Remote Control), iii. Bi-stable
(Set Reset)

Q1,Q2, ... Q8 Base Module
Ul, U2, ... U8 Nonélally Open | Extension Module 1
ontact ;
V1,V2, .. V8 ('NO’ Contact) Extension Module 2
W1, W2, ... W8 Extension Module 3
ql,q2, ....q8 Base Module
ul,u2, ... u8 Noméally Closed Extension Module 1
ontact ;
vl, v2, ... v8 (’NC’ Contact) Extension Module 2
wl, w2, ..... w8 Extension Module 3

TIMERS

Genie-NX provides 16 Timers which can be configured as:
I. ON Delay, ii. OFF Delay, iii. Single Pulse iv. Symmetric/Asymmetric

T1, T2, ..... T16 | Timer Coil / Normally Open (NO) Contact
tl, t2, ... tl6 Normally Closed (NC) Contact
Trigger Input
/— Timer Number
Timer Mode —— Make/Break Status of ‘NO’ Conta
TRG T
Reset Input RES X Locked/Unlocked State
Preset Time Unit S | 000.0 | OF Preset Time Period

006.0

Current Time Unit —— OF — __ Current Time Period

TIME SWITCHES

Genie-NX provides 16 Time Switches which can be used for daily or weekly
applications

01,02, ....016 Normally Open (NO) Contact
01,02, ....016 Normally Closed (NC) Contact
From To
. B & Vi Time Switch No
Current Time 08: 11| ®1
Start Time ON [ 09 15| x —— Make/Break Status
End Time OFF| 12: 00 | @ of ‘NO’ Contact

Locked/Unlocked State

ANALOG COMPARATORS

Genie-NX provides 12 Analog Comparators which can be used for
comparison between values of two analog signals or between a an analog
signal and any absolute value

Al,A2, ... Al6 Normally Open (NO) Contact

Normally Closed (NC) Contact

ANALOG
Compare Input VA 0000
Compare Function > P1 Analog Comparator No

Absolute Value ——ABS| 1023 X8 Locked/Unlocked State

Make/Break Status of ‘“NO’ Contact

COMPARE COUNTERS

Genie-NX provides 16 Compare Counters which can be used for
comparison between values of two counters or between a counter and any
absolute value

I. Up Counter, ii. Down Counter

P1,P2, ..... P16 Normally Open (NO) Contact
pl, p2, ... pl6 Normally Closed (NC) Contact
COMPARE
Compare Input c1 0000

Compare Function > P1 Compare Counter No
Absolute Value ——ABS| 1023 Xl Locked/Unlocked State

Make/Break Status of ‘NO’ Contact

COUNTERS

Genie-NX provides 16 Counters which can be configured as:
I. Up Counter, ii. Down Counter

ClL,C2, ..... C16|Counter Coil / Normally Open (NO) Contact
Normally Closed (NC) Contact

Preset Value ——

Direction Input 0[()) S,—? O,gg?r Current Value
Counter Unit CNT |C1 N Retentive Selection (Y/N)
Reset Unit —— RES |/X @ ~——— Locked/Unlocked State
Make/Break Status
Counter Number of “NO” Contact

AUXILIARY RELAYS

Genie-Nx provides 32 Auxiliary relays which can be used to expand a rung
from one line to another line.

It can be configured as:

I. State Change (Contactor), ii. Level Change (Remote Control), iii. Bi-stable
(Set Reset)

M1, M2, ...M16| Auxiliary Coil / Normally Open (NO) Contact
Normally Closed (NC) Contact

SOFT TEXT MESSAGES

Genie-NX provides 16 Soft Text Message blocks which can be used to
display text messages, the Preset Value and Current Value of any Special
Function Block or the Current Date and time

X1, X2, ..... X16|Used for viewing Alarms, HMI Functionality |

Z-KEYS

Z-Keys are navigation keys provided on device front facia.They behave
exactly like the physical inputs (Discrete inputs). The only difference is
that they do not correspond to smart relay connection terminals, but to the
four gray buttons on the front panel.

71,72, ....7216 Normally Open (NO) Contact
Normally Closed (NC) Contact

-Z-Keys can be used as navigation keys for current displayed menu.
To use Z-Keys go to RUN Screen or RUN LADDER Screen and Press
ALT which will display the Z-Key Screen. Then Press Z1 - Z4.



Functions

Setting the Clock

1. Select the “UTILITIES” option from the Main Menu and press OK.

2. Select the “SET CLOCK” option from the Sub Menu and press OK.

3. The cursor will blink on the first digit of the date, press ALT to edit the digit

4. The digit will now start blinking

5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.

6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7. Now press OK to confirm the changes that have been made.

8. Repeat the same procedure to set the month, year, hour and minutes.

Once all the parameters have been set, pres OK to save the changes and exit.

PROGRAM ok  SETCLOCK . DD/MM/YY ALT  DDIMMIYY
RUN PASSWORD _7, 01/01/11 Ty 01/01/11 z4
PARAMETERS EXT MOD HH:MM HH:MM
UTILITIES BACKLIT CON 09:30 09:30

L DD/MM/YY 23 DDIMMYY 24 DDIMMIYY SAVING DATA
11/01/11 11/01/11 » 15/01/11 .. WAIT
HH:MM P MM HH:MM >
09:30 09:30 09:30

PASSWORD

The password secures access to the following main menu options:
"PROGRAM","PARAMETERS" and "UTILITIES"

Inrun mode password protects the run time parameters and ladder viewing.

The password comprises four numeric digits from 0 to 9. Therefore the password
can have any value between 0 and 9999.

Extension Module Selection

1. Select the “UTILITIES” option from the Main Menu and press OK.

2. Select the “EXT MOD?” option from the Sub Menu and press OK.

3. The cursor will be blinking on ‘A’, press ALT to edit and the ‘A’ will start blinking.
4. Press Up(Z4) or Down(Z2) keys to select or deselect the extension module.

5. Adark square around ‘A’ indicates that the module has been selected.

6. Now press OK to confirm the changes that have been made.

7. Repeat the same procedure if the other modules are to be selected.

8. Press OK to save the changes and the “‘UTILITIES’ sub menu is displayed

PROGRAM  , SETCLOCK EXTENSION o7 EXTENSION
RUN PASSWORD » MODULES 3 MODULES %
PARAMETERS EXT MOD
UTILITIES BACKLIT CON A B C A B C
EXTENSION SAVING DATA SET CLOCK
MODULES ... WAIT PASSWORD
—> — EXTMOD
B C BACKLIT CON

If only one extension module is being used and it has been assigned as ‘A’ on the
extension module using the selection switch then make sure that *A’is selected in the
‘EXT MOD’ option in the ‘UTILITIES’ menu. If more than one extension modules
are being used then make sure that the modules have been assigned and selected
appropriately because this in turn will affect the inputs and the outputs.

Setting the Password

1. Select the “UTILITIES” option from the Main Menu and press OK.

2. Select the “PASSWORD” option from the Sub Menu and press OK.

3. The unlock symbol means that the password is not yet set.

3. The cursor will blink on the first digit of the date, press ALT to edit the digit

4. The digit will now start blinking

5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.

6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7.Repeat the same procedure to set all the 4 digits.

8. Now press OK to confirm the changes that have been made.

9. Again on pressing OK the password is enabled and the Main Menu is displayed

PROGRAM oK SET CLOCK ALT PASSWORD PASSWORD
RUN PASSWORD » OO0 > 7000
PARAMETERS EXT MOD E i
UTILITIES BACKLIT CON
PASSWORD K PASSWORD PASSWORD PROGRAM
7257 3 7257 » ENABLED » RUN
i PARAMETERS
UTILITIES

Backlit Configuration

1. Select the “UTILITIES” option from the Main Menu and press OK.

2. Select the “BACKLIT CONF” option from the Sub Menu and press OK.

3. The ‘Auto’ option will be displayed with the cursor blinking on it.

4. Press ALT to edit and the Auto option will start blinking.

5. Press Up(Z4) or Down(Z2) keys to select other options viz. ON, OFF.

6. Now press OK to confirm the changes that have been made.

7.Press OK to save the changes and the “‘UTILITIES’ sub menu is displayed.

PROGRAM o, SETCLOCK BACKLIT o7 BACKLT
RUN PASSWORD CONFIG CONFIG
PARAMETERS > EXTMOD > b
UTILITIES BACKLIT CON AUTO AUTO

BACKLIT  OK  BACKLIT ok  SAVING DATA SET CLOCK
CONFIG ~—  CONFIG > ... WAIT PASSWORD
— EXTMOD
ON ON BACKLIT CON

AUTO: In AUTO mode, whenever a key is pressed the backlit will be switched
ON and will switched OFF after 10 seconds.

ON: In ON mode, the backlit will be permanently switched ON.

OFF: In OFF mode, the backlit will be permanently switched ON.

Removing the Password

1. Select the “UTILITIES” option from the Main Menu and press OK.

2. Select the “PASSWORD?” option from the Sub Menu and press OK.

3. The lock symbol means that the password is set.

3. The cursor will be blink on the first digit, press ALT to edit the digit

4. The digit will now start blinking

5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.

6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7. Repeat the same procedure to set all the 4 digits.

8. Now press OK to confirm the changes that have been made.

9. Again on pressing OK the password is disabled and the Main Menu is displayed

PROGRAM oK SET CLOCK ALT PASSWORD PASSWORD
RUN » PASSWORD > Oood ' 7000
PARAMETERS EXT MOD
UTILITIES BACKLIT CON ] ]
PASSWORD ~  ~ PASSWORD .~ PASSWORD PROGRAM
7257 3y (7257 | "y, ENABLED
] ]

Ladder Program Protection

1. If the password is already enabled and user attempts to gain access using
wrong password, then an error message is displayed.

2. If four such consecutive attempts are made then user is presented with options
to either delete the entire device data or else revert.

3. If the DELETE ALL option is selected , then all device data including
Password and Ladder is erased. The user can then re program the Ladder using
G-SOFT NX and secure it with a new password.

PASSWORD INVALID
0000 » PASSWORD
] ... try later

After four wrong attempts of entering the Password this Screen as shown below
appears. Pressing OK here, will delete all device data.

PASSWORD oKk  DELETEALL? 4  INITIALIZING
0000 » » DEVICE DATA
a ... WAIT

After four wrong attempts of entering the Password if user presses ESC ,the device
will return to last menu mode from where it has entered in PASSWORD screen.



Functions

Creating or Editing a Ladder

To create anew ladder or edit an existing ladder, select the PROGRAM option from
the Main Menu by pressing OK.

Select the EDIT option to create or edit a ladder.

Inserting a Contact

1. Place the blinking cursor in the required position.
2.PressALT.

3. Choose the required element using the Up or Down keys.

4. Use the Right Arrow key to move to the number.

5. Choose the number using up or down keys.

6. Press ALT or Right Arrow to accept and to go to next position.

11 73 11 74

M1

Inserting a Coil

1. Place the blinking cursor in the required position.

2. PressALT.

3. Choose the required element using the Up or Down keys.

4. Use the Right Arrow key to call-up the number.

5. Choose the number using Up or Down keys.

6. Use the Left Arrow key to move to the type of coil.

7. Choose the type of coil using Up or Down keys.

8. Press ALT or Right Arrow to accept and to go to next position.

11— Q2 ALT
—>

1M1—Q1 Z3 11— Q2

—

I ALT
—>

TRANSFER

The TRANSFER function allows data to be transferred from Memory Card to
Genie NX or vice-versa.

Transferring data to memory card is useful when user wants to load the same
program in many Genie-NX units. In this case instead of using PC user can make
use of memory card, which is capable of storing one program. This feature is
particularly useful on the production line where user is not required to edit and
debug the program and a PC is not available.

In this mode of transfer "PASSWORD"and "UTILITIES"such as Backlight
configuration & Extension module state will also get transferred with the program
ladder.

PROGRAM oK CARD > DEVICE 1 12345678
RUN > DEVICE > CARD, » SA
PARAMETERS DELETE CARD Q 1234 08:30
UTILITIES ESC

Devie to Card

1. Insert the Memory card in the connector after removing the serial cable, if
present.

2. Selectthe "TRANSFER" function from the "PROGRAM" menu.

3. Press the OK key to validate.

4. Select the Device > Card function.

5. Press the OK key to validate.

Card to Device

This transfer is used to reload an application into the Genie-NX. It avoids the need
to re-enter an existing application.

1. Insert the Memory card in the connector after removing the serial cable, if
present.

2. Move cursor to the "TRANSFER" function from the "PROOGRAM" menu.

3. Press the OK key to validate.

4. Select the Card > Device function.

5. Press the OK key to validate.

Entering a Link

1. Place the blinking cursor next to the desired location.

2. Press OK to start the link (" x ","cursor")

3. Move the cursor to the desired location using the arrow keys.

4. As the cursor moves, the link is drawn.

5. Press OK to exit to normal mode.

6. Repeat this action as many times as necessary to link all the elements together as
required

1 Q1 oK

| 1TQ1 72
Q2 —>

11 Q1 ok I2 Q1
Q2 L

Se—>

Deleting a Program Line

Move the cursor to the first column of the line, if necessary delete the elements one
by one to create a blank line. Press Del. The line is deleted.

It is also possible to delete the entire program stored in the Genie-NX. To do this,
call up the "DELETE" option in the Program menu and validate the deletion of all
program lines.

Replacing a Link with a Contact
To replace a link with a contact, simply place cursor at the required location and
press ALT to enter the contact

Changing an Element
To change an element in an existing program, simply move to the element to
change, press ALT and follow the same procedure as when entering a new element

Deleting an Element
To delete an element, simply place the cursor on the required element, then press
Del. Generally, the deleted element must be replaced by a link

Deleting Links between Elements

To delete a link, simply move the cursor next to the desired position, press the OK
key to change the cursor to 4 and press Del. Key. This may delete some of the
required connections, which may be restored by the same method as above

Inserting a Program Line
To insert a program line, simply move cursor to the first column of the line
immediately above the one to create and press OK.

Editing Parameters of Special Function Blocks
Parameters of special Function Blocks can be modified in two modes
1.Run Mode 2. Program Stop Mode

Run Mode

1. Enter the PASSWORD if it has been enabled.

2. Special function block with it's parameters set will get display.

3. Set parameters & press OK to save the parameters.

4. Press ESC to return Run Mode Menu .

5. Ifuser do not press OK and do press ESC previous settings retains & returns to
Run Mode Menu

PAUSE OK PASSWORD oK D|TRG | T1
STOP N N RES | X&
PAR RUN E":“:":l S |000.0 | OF
PROG RUN f S |006.0 | OF

D|[TRG | T1 PAUSE

RES | x@ F5C  stoP
S|000.0 [ OF PAR RUN
S| 006.0 | OF PROG RUN

Program Stop Mode

Enter the PASSWORD if it has been enabled and press OK to save the parameters
If user do press ESC key without pressing OK the screen as shown will appear,so
that user can have three options as:

EDIT: Again enter into parameter set mode.

SAVE AND EXIT: Save the parameters & come out of mode.

EXIT: Retain previous settings & come out of set mode.

PAUSE PROGRAM OK PASSWORD D| TRG T1i
STOP y RUN » |:||:||:||:| » RES | X
PAR RUN PARAMETERS f S|000.0 | OF
PROG RUN UTILITIES S|006.0 | OF
D TRG T1 oK SAVING DATA
RES XA ... WAIT
S 000.0 OF
S 006.0 OF
ESC EDIT
SAVE & EXIT
EXIT



Functions

RUN MODE

To enter into RUN mode select the "Run" option in the main menu and press 'OK".

PROGRAM CONTINUE 112345678
RUN OK BRESER OK SA
PARAMETERS Q1234 08:30
UTILITIES ESC

If the CONTINUE option is selected then Ladder Program execution will proceed
& the Run mode display screen will appear as shown

If the RESET option is selected then all special function block parameters are
initialized & the Run mode display screen will appear

Run Mode Functions

During the Run mode the user can enter the Run Mode Functions by pressing the
ESCkey

1 12345678 n ESC 2/;3?’5 % g(E)gngNUE ok 112345678 "
—> —>
Q1234 08:30 PAR RUN Q1234 08:30
ESC PROG RUN ESC
3 +
PAUSE OK PROGRAM
STOP » RUN
PAR RUN PARAMETERS
PROG RUN UTILITIES
z3 #
PAUSE oK D TRG T1
STOP — RES XA
PAR RUN S 0000 OF
PROG RUN S 006.0 OF
z3 +
PAUSE
STOP oI
PAR RUN
PROG RUN
PAUSE

Ifthe PAUSE option is selected by pressing OK then program execution is paused.
And user can have two options as

Continue: Run with the parameters status it has or

Reset: Reset the parameters and run the program.

STOP

If the STOP option is selected by then the program execution is stopped & Main
Menu s displayed on the screen.

PAR RUN

-Ifthe PAR RUN option is selected then Parameter edit window of Special Function
Block is displayed. The user can edit the parameters by using ALT, UP, DOWN &
OK keys.*

PROG RUN

-If the PROG RUN option is selected then the ladder program is displayed on the
screen. The user cannot edit the program and can only go through the program by
using UP, Down keys

IfZ-Keys are used in the program then pressing the ALT key will display the Z-Key
screen.

PAUSE 2 V'S
STOP

PAR RUN Z3 ‘v’
PROG RUN i

* Embedded parameters when unlocked and edited at run time will not be saved permanently in the device. This functionality is
provided only to test the system during run time. To save parameters permanently, user has to stop the program, move to edit mode &
configure the system accordingly.

Note: InRun Mode, extension module identities cannot be changed

MODBUS SETTINGS
Slave ID

1. Select the “PROGRAM” option from the Main Menu and press OK.

2. Select the “MODBUS CONE” option from the Sub Menu and press OK.

3. The cursor will blink on the first digit of the Salve ID (SLV ID).

4. Press ALT to edit the digit and the digit will now start blinking

5. Using Up(Z4) and Down(Z2) keys select the appropriate digit.

6. Now press Z3 to edit the other digit and using Up & Down keys select the digit.
7. Now press OK to confirm the changes that have been made.

PROGRAM EDIT SLVID 001, - SLVID 001
RUN OK_ | DELETE OK BAUD 9600 BAUD 9600 Z4
PARAMETERS > TRANSFER P PARITY NONE PARITY NONE
UTILITIES MODBUS CON STOPBIT 1 STOPBIT 1
SLVID 101 SLVID 101 | 5, SLVID 111 SLVID 111
BAUD 9600 BAUD 9600 BAUD 9600 ©OK BAUD 9600
PARITY NONE PARITY NONE — » PARITY NONE PARITY NONE
STOPBIT 1 STOPBIT 1 STOPBIT 1 STOPBIT 1
Baud Rate

8. Now press Z3 to select Baud Rate (BAUD) and press ALT to edit..
9. Using Up(Z4)and Down(Z2) keys select the appropriate Baud Rate.
10. Now press OK to confirm the changes that have been made.

SLVID 111 SLVID 1M1

SLVID 101 SLVID 111

BAUD 9600 BAUD 9600 _“}, BAUD 0300 _OX BAUD 0300
PARITY NONE PARITY NONE PARITY NONE PARITY NONE
STOPBIT 1 STOPBIT 1 STOPBIT 1 STOPBIT 1
Parity
11. Now press Z3 to select ‘PARITY”and press ALT to edit..
12. Using Up(Z4) and Down(Z2) keys select the appropriate parity.
13. Now press OK to confirm the changes that have been made.
SLVID 111 SLVID 101 SLVID 111 SLVID 111
BAUD 0300 BAUD 9600 BAUD 0300 ©OK BAUD 0300
PARITY NONE PARITY NONE PARITY ODD PARITY ODD
STOPBIT 1 STOPBIT 1 STOPBIT 1 STOPBIT 1
Stop Bits
14. Now press Z3 to select ‘STOPBIT’ and press ALT to edit..
15. Using Up(Z4) and Down(Z2) keys select the number of stop bits.
16. Now press OK to confirm the changes that have been made.
SLVID 111 53 SLVID 111 24 SLVID 111 SLVID 111
BAUD 0300 3 BAUD 0300 » BAUD 0300 BAUD 0300
PARITY ODD PARITY ODD PARITY ODD PARITY ODD
STOPBIT 1 STOPBIT 1 STOPBIT 2 STOPBIT 2
17. Once all the changes have been made press OK to save and exit.
SLVID 111 SAVING DATA EDIT
BAUD 0300 > ...WAIT __y, DELETE
PARITY ODD TRANSFER
STOPBIT 2 MODBUS CON

Parameter Lock

When user edits parameter from text message and if parameter is locked then above screen
appears. To change that parameter user has to edit that parameter in edit mode only.

PARAMETER
LOCKED




Programming using the G Soft-NX Software

G-Soft NX is the exclusive programming software for the Genie NX using Windows®. It facilitates:

Entering the Program: Select & Place

G-SOFT NX provides a user-friendly interface wherein the user has to only select contact type and contact
number and place it where it is required. Contacts get connected automatically if they are on the same line.
User can enter comments for better readability and for future reference .

Saving Programs
G-SOFT NX allows user to save individual programs on the PC.

Debugging
G-SOFT NX is very powerful in error handling. It displays any possible errors as the program is being
entered to make corrections simultaneously.

Simulation on PC

User can simulate the program on PC. User can use buttons provided on the screen to simulate the input
connections. Scroll bar can be used to simulate Analog input. The actuation/ de-actuation of the relays can
be monitored on the screen.

Simulation on Genie NX

User can connect Genie-NX unit to PC using a serial Communication cable / USB cable and perform on line program simulation. In this mode the PC acts as a master and the
inputs are taken from Genie-NX and outputs are sent to Genie-NX unit (and the extension modules, if connected). This mode is useful in debugging the entire system since the
actual I/Os are used.

Printing

User can take print outs of programs in two different formats, namely Short format and Detail format. Also, program Parameters and Comments can be printed.
Transfering Programs

Programs can be transferred from PC to Genie-NX and vice versa using serial Communication cable / USB cable. This saves the program entering time on Genie-NX.
Transfering Clock

With this utility user can set the clock (date and time) on Genie-NX.

Program Editor
Window —»

[/O Function
Selector Window

<«

Input/Output AT a5 e T Cle [ »|vi=moo0 ([ »[v2-0000 @01 @02 03 QO4

Window Tl T2 T3 T 04 U5 T 7 T o[ »fvE=0000 ([[ »|v4=0000 gl glU2 Ui gUd
| MKl T K2 K3 K4 K5 [ KE [ K7 [ K8 L|_| ﬂva:nnun ‘_L| ﬂva:nnnn avl oV? oVl oyl
[FurerBrurisrerw Ce f f[w=000 [ »[v8-0000 oWl oW2 oWi owd

Error Window —

Select File -> New from the menu bar to create a new program.
Ablank screen will appear. Now you can start entering the program. Ensure that you have chosen proper Genie-NX Configuration before starting the program entry.

Choosing Contact Type

Position the cursor at the place where you want to insert the contact by a left click with mouse. The position will get highlighted. Choose the required contact type and Contact
Number from I/O function selector. Click on the required contact and contact number, which will be highlighted for a few seconds. The selected contact will appear at the
position selected in the program. The selected contact number will be shown with a tick mark to indicate that it has been used in the program. You can right click on any of the
contact to change its type and properties.

Connecting Inputs & Outputs
Each circuit connection runs from left to right. Please remember this when you interconnect contacts and relay coils. User can draw a circuit connection horizontally from left
toright and vertically between adjacent circuit connections. An intersection of circuit connections represents an electrical connection.

Horizontal connection
To make a horizontal connection, click on the horizontal dotted line in the connection box of the circuit. Or to make connection in contact box, press right button and select
"Joining link". Generally when an output coil is placed in the fourth column, it gets automatically connected.

Vertical connection
To make a vertical connection click on the vertical dotted line in the connection box of the circuit. Vertical connection represents OR connection. For deleting a connection
just left click on the connection line.



Working with Gsoft-NX

To Set & Remove Password

Select the Configuration >Device Utilities menu command. Then Device Utilities window
will pop up as shown in the adjoining window.

Click on set password.

Enter four digits password in the two boxes “New password” and “Confirm New”
Password then confirm with OK.

You can delete your assigned password at any time. To do this, enter the existing password
in “Old password” box. Then confirm with OK.

To change the password, you must first enter the new password in the two boxes “New
password” and “Confirm Password ““ and the existing password in Current password text
box. Then confirm with OK.

To Set Backlit Mode

Select the Configuration >Device Utilities menu command. Then Device Utilities window
will pop up as shown in the Com Port Settings window.

Select the mode Auto, On or Off then click on the set mode button.

Then “The requested operation will move the device out from the run mode. Do you want
to continue?”” message will pop up.

If pressed Yes, then backlight mode will get set in device and "Backlight mode has been set
successfully" message will appear on the screen.

To Configure Communication Port

Select the Options > Comm port menu command. Then COM Port setting window will pop
up as shown in the adjoining window showing two option buttons to select the Port.

Select “Device is connected to USB port” when the device is connected with cable.

Select “Device is connected to Serial Communication port” when the device is connected
with Serial Communication cable.

Set Communication Parameters

Select the Options > Comm port menu command. Then COM Port setting window will pop
up as shown.

The user can set the following communication parameters:

SLAVE ID: Selectable from 1 to 247.

BAUD RATE: Selectable as 1200,2400,4800,9600 baud.

PARITY: Selectable as NONE, EVEN and ODD.

STOP BIT: Selectable as 1 and 2 stop bits.

Clock Setting

Select the Transfer > Device Clock menu command. Then Device Clock window will pop
up as shown in the Device Clock window.

To view Date and time of device: Click Read button on the clock setting window. Then the
Clock Setting window will show the Date and Time of the device.

To set Date and time in the device: User can select Date and Time to write into the device.
Click Write button on the clock setting window.

DST (Daylight Saving Time) Setting

Select the Transfer > Device Clock menu command. Then Device Clock window will pop
up as shown in the adjoining window.

To set Enable DST, Follow the following steps: Click Daylight Saving Time check box then
the DST setting section becomes visible.

User can select the following parameters: Begin Week, Begin Day, Begin Month, Begin
Time, End Week, End Day, End Month, End Time, Offset Time

To set Disable DST, Follow the following steps:

1. Deselect Daylight Saving Time option then DST window will get disable.

2. Press Set DST.

To read DST: Press Read DST, independent of the DST enable or disable.

Transfer Options
PC to Device

Select the Transfer > Program menu command. Then transfer window will pop up as shown
in the Transfer Window

Press "PC to Device" button on transfer dialog box. Current program on the screen will get

transferred to device.

Transfer completion message "The Program is downloaded successfully" will appear on the
screen.

Device to PC

Select the Transfer > Program menu command. Then transfer window will pop up as shown
in the adjoining window

Press "Device to PC" button on transfer dialog box. Current program

on the screen will get transferred to device.

Transfer completion message "The Program is downloaded

successfully" will appear on the screen.

Read program will be shown on main screen.

Extension Module Selection

Select the Configuration >PLC Model menu command. Then Model
Selection window will pop up as shown.

Selection of Genie-NX model and Extension modules. Maximum
three extension modules can be connected to one Genie-NX.



Sample Programs

FACTORY/SCHOOL SCHEDULE
Opening bell at 8am announces start of work or class (bell to last 10 sec and stop): Bell at 10:30am announces start of coffee break, Bell at 10:45am announces end of coffee
break, Bell at 12noon announces lunch, Bell at 12:45 announces end of lunch, Bell at Spm announces end of work day

Programming

For the 6 time periods 6 Time Switches are required. ®1,®2, ....® 6 represent the 6 Time Switches.
Timer T1 ensures that the duration of the output is 10 seconds only.

Q1 represents the Output Coil (Alarm/Bell in this case)

Double click on the G SOFT NX icon the launch the G SOFT Software application.

ClickonFile New to launch anew Program window.

Time Switch Selection & Parameter Editing

1. Click on the Time Switch symbol in the I/O selector window and select Time Switch 1 (® 1)

2. Move the cursor to the ‘Contact 1' column of the first row and left click on the block to place the Time Switch.

3. Right click on the Time Switch and select properties to open the properties window.

4. In the Weekday settings option select ‘From’as Monday ans ‘To’as Saturday.

5. Inthe Daily Duration option enter the start time as 10:30 and since we want the siren for 10 sec. enter end time as 10:31.

6. Similarly select the other 5 Time Switches and enter the times as described above and place them in the contact 1 column of lines 2, 3, 4,5 & 6.

Contact-1 =1 Line Insert Wwieskday settings : Dellychraion: A bt
— Fram : |Monday | Start time :

End time :

\4
\ 4

@2
[63 |

Sa
NEEEE
Lel Lo

i To: |Saturday

<>

Timer Selection & Parameter Editing

7. Select Timer T1 from the I/O selector window and place it in the coil column of line 1and contact column of line 7.
8. Open the Timer properties window and select the mode as Interval and enter the time duration i.e. SPas 10 sec.
9. Connect the lines from all the Time Switches to the Timer as shown in screen.

- Mode
Cail End of Class =]
+ SEC
4 _|OnDel
> TN —— gy [ T il e > 000 ~ MM:SS
C £ HH:MM
D | Asyrmmetric
Output Configuration
10. Select Output Q1 from the I/O selector window and place it in the coil column
11. Right click on output Q1 to and select the option ‘State Change: Contactor’
]
Oip
» {Ql — State Change: Contactor
-(% | [school Bel Level Change: Remate Contral
AUX
)
LADDER PROGRAM
Contact-1 Connection-1 Contact-2 Connection-2 Contact-3 Connection-3 Coil
] f . : 1Tl
02 o L RS Y S R
Start of Coffes : :
03 L C U [ O S S Y R P e
End of Coffee break] 5 5
04 L SN (S O S S R P S R S
Start Lunch Break D D
05 L L ) s R Y S S
End of Lunch Break] 5 5
06 a6 R Y S R R P e
End of Clazs ; g g
o7 n . : : {91
. : : School Bell




Sample Programs

CAR PARKING
There are 5 parking spots available in a parking area. There are 2 sensors, one at the entry gate and one at the exit gate. When all the parking spots are occupied, there is a lamp
outside the entry gate indicating parking is full. When any of the parking spots is available, other lamp is switched ON indicating parking is available.

Programming

InputIlis the sensor at the Entry gate and Input 2 is the sensor at the exit gate.

Output Q1 indicates that Parking is available, Output 2 indicates that Parking is Full.

Counter C1 is used to count the number of vehicles that have entered or exited the parking.

Compare Counters P1 & P2 are used switch ON outputs Q1 & Q2 respectively by comparing the count of counter C1.

Input Selection

1. Click on the Input symbol in the I/O selector window and select I1.
2. Move the cursor to the Contact 1 column of the first row and left click on the block to place the input.
3. Againclick on the Input symbol in the I/O selector window and select ‘12°.
4. Move the cursor to the Contact 1 column of the second t row and left click on the block to place the input. Also place it in the Contact 1 column of the third row.
“| 1P a5 v |11 |Enty ~| LiP ar W |11 |Ent )
:‘ F’i‘ 'n"ﬂ |2 [Esit > :I E‘ > 'n"ﬁ o |2 [Esit >z —
= I3 = I3
g-f:'! Bas KT T4 glf:! Ban kT I

Counter Selection & Parameter Editing
5. Select Counter C1 from the I/O selector window and place it in the coil column of line 1. Right click on the counter and select the option counting input.
6. Againselect the same counter C1 and place itin the coil column of line3 . Right click on the counter and select the option direction input.
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Compare Counter Selection & Parameter Editing
7. Select Compare Counter P1 from the I/O selector window and place it in the contact column of line 4.
8. Right click on the compare counter and select properties.
9. Under the compare selection option, select ‘F1’as ‘C1°, ‘OP’as ‘<’, ‘F2’as ‘Abs Value’and reference count as 5.
10. Select Compare Counter P2 from the I/O selector window and place it in the contact column of line 5.
11. Right click on the compare counter and select properties.
12. Under the compare selection option, select ‘F1’as ‘C1°, ‘OP’as ‘=", ‘F2’ as ‘Abs Value”and reference count as 5.

- L[5 Compare selection Reference caount
P S e S I N —
| ;‘ﬁ v 11:': | o1 ~ < =] [absvae ]
T bl -
. /4,_ I 1
- (K % Cornre Compare selection Reference count
¢y el v p1 > — F2 > F1 0F F2
P I P 5
— s = Cl ~| = =] [absvaue  ~|
T bl -

Output Configuration

13. Select Output Q1 from the I/O selector window and place it in the coil column
14. Right click on output Q1 to and select the option ‘State Change: Contactor’

f—|
H fo1
3% » Parking Available ':'-tate Change: Contactor
Level Change: Remaoke Control
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Technical Specifications

* Energy management

* Heating Control

* Cooling systems

* Ventilation systems

* Air conditioning systems

Machine Controls

* Motor, pump and valve controls
* Air compressors

* Exhaust and filtering systems

» Water-treatment plants

» Woodworking machinery

* Etching and purification plants

Residential and Commercial Building Services

* Interior and exterior lighting control

* Door/gate control

* Shutter, sun blind and awning control

» Irrigation system control

Supply Voltage 110 - 240 VAC 12 -24 VDC

Supply Variation -20% to +10% -20% to +10%

Frequency 50/60 Hz

Power Consumption 5VA 5 VA

Analog Inputs N.A. 2

Analog Input Range N.A. 0-10VDC

Digital Inputs 8 8

Digital Input Range (0 - 40 VAC) OFF, (80 - 264 VAC) ON (0-4VDC) OFF, (8 - 26.4 VDC) ON

Outputs 4 4

Contact Rating 8A @ 240 VAC/ 5A @ 30 VDC 8A @ 240 VAC / 5A @ 30 VDC

Input / Output Extension (Max) Yes (3) Yes (3)

Power Reserve (For clock only) 150 h 150 h

Timers 16 16

Time Switches (Daily/Weekly) 16 16

Counters (Up/Down, Retentive selectable) 16 16

Compare Counters 16 16

Soft Text Messages 16 (Priority Driven) 16 (Priority Driven)

Analog Functions N.A. N.A.

Auxiliary Relays 32 32

Lines for Ladder Programming 250 250
ORDERING INFORMATION

G7DDT9 110 - 240 VAC, Genie Nx Base Module

G8DDT9 12 - 24 VDC, Genie Nx Base Module

G7DDT6E 110 - 240 VAC, Genie Nx Extension Module

G8DDT6E 12 - 24 VDC, Genie Nx Extension Module

G7XDTR4 110 - 240 VAC, Genie Nx RS 485 Communication Module

G8XDTR4 12 - 24 VDC, Genie Nx RS 485 Communication Module

GFDNN3M Memory Card

GFDNN2S RS 232 Serial Communication Cable

GFDNN1 USB Cable

GNXNNI1 Genie Nx Software supplied on CD-ROM compatible with Windows 98, 2000, XP & Vista
APPLICATIONS

HVAC Controls Transport facilities

 Conveyor systems

* Hoisting platforms

* Elevators

« Silo facilities

* Livestock feed delivery

Operational Monitoring Systems

* Access control

* Vehicle control monitoring
* Alarm systems

* Level limit monitoring

* Traffic light control systems
* Baggage handling

Other Applications

* Solar-electric systems

» Marine applications

* Harsh environments

* Display panels and traffic
control signs
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